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Introduction

• Audience – People who work with Intelligent Advisor policy models. It is 
assumed the reader has already had training and is familiar with using OPM.

• Purpose – Provide ideas and suggestions for polishing your policy models, 
and direct you to relevant articles in the Intelligent Advisor Documentation.

• Software version – Deck prepared for Oracle Policy Modeling (20B).

• Acronyms

–OPM – Oracle Policy Modeling
Tip: Latest version of the 

Intelligent Advisor  
Documentation Library can be 

found online and via the 
question mark button in OPM

* Intelligent Advisor previously called Policy Automation (OPA)

https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Default.htm
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Example Projects

• OPM includes Example Policy Models that demonstrate features discussed in this deck
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Filter examples by Industry and Feature

Example projects available 
from the Project tab

Example projects available 
from the Project tab

https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Projects/Example_policy_models.htm
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Tips for Polishing Your Policy Model

• Screen Configuration

– Labels on Interview Screens

– Interview Stages

– Navigation Strip

– Containers

– Entity Collect Screen

– Adding Images to Interview Screens

• Enhancing Interviews

– Look and Feel of Interviews

– Document Generation using BI 
Publisher

– Capture the User’s Location

– Configuring Attribute Value Formats

– Configuring Standard Message Strings

• User Input

– Default Values

– Value Lists

– Hint Text

– Validating User Input – Event rules

– Validating User Input – Data tab

– Input Masks

• Substitution and Sentence Generation

– Name Substitution

– Gender Pronoun Substitution

– Second Person Sentence Generation

– Substituting Names in Labels

• Language Support

– Adding a Verb to the Default Verb List

– Adding a Translation Layer

– Writing Rules in Other Languages

• Improving the Explanation

– Intermediate Attributes

– Rule Tags

– Trimming Explanations – Attributes

– Trimming Explanations – Relationships

4
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Screen Configuration

5
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Labels on Interview Screens

• Labels can:

– be added to provide context and additional info

– be used as additional headings and subheadings

– include raw text, as well as HTML

– have conditional visibility

– contain substitution

6

Documentation Library

• Add text to screens

• Add a label control

• Specify the type of 
label

• Hide and show screen 
controls

• Show attribute values 
on screens

• Show attribute 
values in other 
screen text

• Use embedded HTML in 
an interview

Example labels

https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Screens/Add_text_to_screens.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Screens/Add_a_label_control.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Screens/Specify_type_of_label.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Screens/Hide_and_show_screen_controls.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Screens/Show_attribute_values_on_screens.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Screens/Show_attribute_values_in_other_screen_text.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Design_interviews/Use_HTML_in_interview_text.htm
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Documentation Library

• Organize an interview 
into stages

Interview Stages

• Group related interview screens together in a folder

• Folder becomes a stage in the interview
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Interview screen

Interview stage

Interview (runtime)

Interview screen

Interview stage

OPM (design time)

https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Design_interviews/Organize_interview_into_stages.htm


Copyright © 2020, Oracle and/or its affiliates. All rights reserved.  |

Navigation Strip

8

Documentation Library

• Configure the navigation 
strip

• Navigation strip may 
be displayed at the 
top or left of the page

• Many configuration 
options available, e.g. 
text color, text size, 
background color

Ribbon

Train stops

Left menu

Thermometer

https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Design_interviews/Configure_navigation_strip.htm
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Containers

• Containers may be used to lay out screen controls side-by-side

• Containers allow for responsive design in interviews, e.g. two 
columns which collapse to a single column in a small browser

• Labels and images may also 
be put in containers

9

Documentation Library

• Change control layout 
for a screen

• Example project: 
myBenefits

Screen controls automatically 
collapse to one column in a 

narrow browser window. More 
readable on a small screen.

Screen controls laid 
out in two columns. 
Efficient use of space 

on a larger screen

https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Screens/Change_control_layout_for_a_screen.htm
https://opalive-opa.custhelp.com/opalive_opa/web-determinations/startsession/myBenefits
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Entity Collect Screen

• Entity collection layout can be ‘portrait’ or ‘tabular’ style

• Tabular will usually make more efficient use of screen space

• Containers can also be used inside the entity collect space to 
control layout

10

Documentation Library

• Collect entity instances

• Example project: 
myBenefits

Entity collect screen 
with tabular layout

https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Screens/Collect_entity_instances.htm
https://opalive-opa.custhelp.com/opalive_opa/web-determinations/startsession/myBenefits
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Adding Images to Interview Screens

• Add images to interview screens as useful visual aids

• Many configuration options available for images, e.g. 
horizontal alignment (left, center, right), image size, 
conditional visibility, clickable link
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Documentation Library

• Add images to screens

• Refer to images using 
HTML tags

• Place other controls 
within a container

• Example project: 
Energy Saver

• Images may be placed in 
containers for further 
layout control

• Use text substitution to 
insert different images 
depending on the value 
of a substituted attribute

https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Screens/Add_images_to_screens.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Design_interviews/Refer_to_images_using_HTML.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Screens/Place_other_controls_within_container.htm
http://opalive-opa.custhelp.com/opalive_opa/web-determinations/startsession/energysaver
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Enhancing Interviews
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Look and Feel of Interviews

• Many aspects of the interview look and feel can be set in the 
Styles section of the Interview tab, e.g. color scheme, banner 
graphic, heading styles, button location, footer and header

13

Documentation Library

• Configure the appearance 
of the interview

• Change the appearance of 
interview items

Interview and 
the Debugger

Styles section in OPM

https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Design_interviews/Configure_appearance_of_interview.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Design_interviews/Change_appearance_of_interview_items.htm
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Document Generation using BI Publisher

• Generate documents from interviews, e.g. letters, forms, etc. 
OPM supports creation of RTF, PDF, HTML, XML & Excel forms

• Forms may include text, images, charts, explanations, signatures

• Note: Requires installation of BI Publisher Desktop. This is a 
separate product. It is not part of Oracle Policy Modeling.
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Documentation Library

• Forms

• Create or modify a form

• Overview of designing a 
form

• Design an RTF template or 
a PDF template for a form 

• Add forms to screens

• Insert a signature into a 
form

• BI Publisher code for Policy 
Modeling

• Download BI Publisher

• Troubleshooting guide for 
forms

• Example: Healthy Eating

https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Forms/Forms.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Forms/Create_or_modify_form.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Forms/Overview_of_designing_a_form.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Forms/Design_RTF_template_form.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Forms/Design_PDF_form_template.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Screens/Add_forms_to_screens.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Forms/Insert_signature_into_RTF_form_template.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Forms/BI_Publisher_code_for_OPM.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Forms/Download_BI_Publisher.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Forms/Troubleshooting_BIP_with_OPM.htm
https://opalive-opa.custhelp.com/opalive_opa/web-determinations/startsession/HealthyEating
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Capture the User’s Location

• User’s location (latitude and longitude) may be captured 
during the interview using standard browser location support

• Latitude and longitude may be used in rules, e.g.
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Documentation Library

• Capture the user’s 
location

• Example projects: My 
Store App, Emergency 
ResponseGenerate map URL to 

add to interview screen

Compare distance between locations

https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Screens/Capture_user_location.htm
https://opalive-opa.custhelp.com/opalive_opa/web-determinations/startsession/MyStoreApp
https://opalive-opa.custhelp.com/opalive_opa/web-determinations/startsession/EmergencyResponse
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Configuring Attribute Value Formats

• Default attribute value formats are based on the project 
region (for non-Boolean attributes) and the project language 
(for Boolean attributes)

• E.g. If project language = ‘English (American)’ and 
region = ‘United States (English)’ then:

– Default currency symbol: $

– Default date out format: MM/dd/yyyy

– Default Boolean values: Yes/No

• Default attribute value formats can be modified in: 
Project > Language > Formatting

• Generally will not need to edit default formats, 
but configuration options are there if needed

16

Documentation Library

• Change the formatting 
of attribute values in an 
interview

https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Design_interviews/Change_formatting_of_interview_attribute_values.htm
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Configuring Standard Message Strings

• Default message strings and labels (e.g. standard error text, 
alt-text, button labels, etc.) can be modified in Interview > 
Styles > Strings

• Generally will not need to edit default message strings, but 
configuration options are there if needed

• Note: Button labels (e.g. Next, Back, Submit, Add New 
Instance, Remove) can also be modified on a per-button basis

• To change all occurrences of a message string →modify the 
default string, e.g. to use ‘Continue’ instead of ‘Next’ as the 
standard label on a Next button

• To change one occurrence of a button label →make the 
change on the individual screen

17

Documentation Library

• Change the text of 
buttons, messages and 
other built-in interview 
items

https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Design_interviews/Change_text_of_interview_items.htm
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User Input

18
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Default Values

• Can set default values for inputs on interview screens

– Defaults can be specific values, or can be dynamically determined 
based on previously collected data, or inferred from rules

• Reduces the typing/clicking required to complete an interview

19

Documentation Library

• Specify a default for an 
input

All currency values have been defaulted to $0. 
User only needs to edit the fields for which 

they have income. Reduces manual data entry.

https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Screens/Specify_default_for_input.htm
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Value Lists

• A value list is a way of managing lists of values for attributes

• A single value list can be attached to multiple attributes, e.g. 
the person’s home address, the person’s work address

• Value lists can be created manually, imported from another 
OPM project, or loaded in from a Service Cloud connection or 
web service connection.

20

Documentation Library

• Value lists

• Set up a value list in a 
project

• Associate a value list 
with an attribute 
collected on a screen

• Hide and show 
individual items in a 
value list

• Button types

• List types

• Example projects: Loan 
Advisor, myBenefits

Value list displayed as 
image buttons

• Value lists can be 
displayed as lists, 
radio buttons, 
text buttons, 
images, sliders

https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Value_lists/Value_lists.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Value_lists/Set_up_a_value_list_in_a_project.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Value_lists/Associate_a_value_list_with_an_attribute.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Value_lists/Hide_and_show_individual_items_in_value_list.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Screens/Button_types.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Screens/List_types.htm
https://opalive-opa.custhelp.com/opalive_opa/web-determinations/startsession/LoanAdvisor
https://opalive-opa.custhelp.com/opalive_opa/web-determinations/startsession/myBenefits
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Hint Text

• Can supply hint text for inputs on interview screens

– Hint text appears until the user clicks into the input field

• Tip: Always add hint text when the format of the input is 
important, for example:

– Date fields

– Any sort of ID number like SSN, TFN, NINO, PHN

21

Documentation Library

• Specify hint text

Hint text showing the 
required date format

https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Screens/Specify_hint_text.htm
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Validating User Input – Event Rules

• Error event and Warning event rules may be used where 
there is conditional logic associated with the validation, e.g.

– Display the message “Please check the dates of birth. You have 
indicated that your date of birth is after your child’s date of birth.”
if the applicant’s date of birth > the child’s date of birth

• Error event: Error message is displayed and the user is 
prevented from continuing until the situation that triggered 
the event is no longer present.

• Warning event: Warning message is displayed, but the user is 
able to click past and continue the interview.

22

Documentation Library

• Validate user input

• Write rules to validate 
user input

https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Screens/Validate_user_input.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Work_with_rules/Write_rules_to_validate_user_input/Write_rules_to_validate_user_input.htm
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Validating User Input – Data Tab

• Validation with regular expressions and min/max can be done 
on the attribute in the Data tab

– Error text may be configured on a per attribute basis

• Use min/max values if there is no conditional logic for 
triggering the error, e.g.

– ‘the person’s age’ field could have a minimum allowable value of 
0 and a maximum of 120

• Use regular expressions to validate the format of an input 
such as an email address, an SSN, a TFN, a NINO or a PHN, e.g.

– ^[0-9]{3}-?[0-9]{2}-?[0-9]{4}$ is a basic SSN validation – allows for 
NNN-NN-NNNN and NNNNNNNNN

23

Documentation Library

• Validate user input

• Specify validations on 
individual inputs

Other info

• http://en.wikipedia.org/
wiki/Regular_expression

https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Screens/Validate_user_input.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Screens/Specify_validations_individual_inputs.htm
http://en.wikipedia.org/wiki/Regular_expression
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Input Masks

• Masked input text boxes may be used to auto-format data
entered into text fields, e.g. phone numbers, social security 
numbers, product codes, etc.

• Input masks can effectively act as a type of validation since the 
input field won’t allow the user to type offending characters, 
e.g. an input mask containing only numbers will not allow 
letters to be entered.

• Masked input text boxes can only be used with text attributes.

24

Documentation Library

• Masked input text boxes

Uses the input mask: 
(999) 999 9999

Uses the input mask: 
A*999AA*

https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Screens/Masked_input_text_boxes.htm
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Substitution and Sentence Generation

25



Copyright © 2020, Oracle and/or its affiliates. All rights reserved.  |

Name Substitution

• Personalizes the interview for a more user-friendly experience

• Collect the person’s name early in the interview, then 
substitute the name in later questions, e.g. “Does the person 
have insurance?” becomes “Does John have insurance?”

• Particularly important when using entities, e.g. “Is the child a 
full-time student?” becomes “Is Emma a full-time student?”, 
“Is Joshua a full-time student?”, etc.

• Substituted name automatically appears in attribute text on 
interview screens and in explanations

• If first and last name collected separately, use concatenation 
to combine if full name needed for substitution in attributes

26

Documentation Library

• Personalize attribute 
text

• Enable substitution 
in Policy Modeling

• Understand text 
substitution 
principles

• Combine multiple text 
strings into a single text 
attribute

https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Attributes/Personalize_attribute_text.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Attributes/Enable_substitution_in_OPM.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Attributes/Understand_text_substitution_principles.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Work_with_rules/Write_rules_using_text_strings/Combine_mult_text_strings_into_single_text_variable.htm
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Gender Pronoun Substitution

• May be used in combination, or in isolation, with name 
substitution to personalize the interview for a more user-
friendly experience, and to provide more natural language text

• Gender pronoun substitution requires collecting gender

27

Documentation Library

• Personalize attribute 
text

• Enable substitution 
in Policy Modeling

• Substitute a 
pronoun for a text 
attribute

• Understand text 
substitution 
principles

• Collect the gender of a 
person

In combination with name substitution, “Has the 
applicant submitted the applicant’s tax return?” 

becomes “Has Christopher submitted his tax return?”Original rule 
generically refers 
to “the applicant”

https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Attributes/Personalize_attribute_text.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Attributes/Enable_substitution_in_OPM.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Attributes/Substitute_a_pronoun_for_text_attribute.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Attributes/Understand_text_substitution_principles.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Screens/Collect_gender_of_person.htm
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Second Person Sentence Generation

• Similar concept to name substitution, but sentences/questions 
generated in second person rather than third person

• Requires name substitution to be set up first

• Works with gender pronoun substitution if it has been set up

28

Documentation Library

• Display interview text in 
second person form

• Also see the articles for 
Name Substitution

Example: Instead of “Has the 
applicant submitted the applicant’s 
tax return?” it displays “Have you 

submitted your tax return?”

Example: Instead of “Does the 
applicant have health 

insurance?” it displays “Do 
you have health insurance?”

https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Screens/Display_interview_text_in_second_person_form.htm
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Substituting Names in Labels

• Variable values (e.g. person’s name, age, etc.) can be 
substituted into labels on interview screens

• Requires name substitution to be set up first

• Tip: For substitution in labels, make sure the substitution 
values will always be known in advance of the screen being 
displayed, otherwise “unknown” will appear in place of the 
substitution value

29

Documentation Library

• Personalize attribute 
text

• Enable substitution 
in Policy Modeling

• Understand text 
substitution 
principles

• Show attribute values 
on screens

• Show attribute 
values in other 
screen text

Example: The person’s name and age 
were collected on a previous screen, 

and those values have been substituted 
into label text on the School screen

https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Attributes/Personalize_attribute_text.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Attributes/Enable_substitution_in_OPM.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Attributes/Understand_text_substitution_principles.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Screens/Show_attribute_values_on_screens.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Screens/Show_attribute_values_in_other_screen_text.htm
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Adding a Verb to the Default Verb List

• Default verb list for the policy model is based on the Rule 
Language selected when creating the project

• Occasionally you may need a new verb

• If a Boolean won’t parse properly, it’s 
a sign the statement’s operative 
verb may not be in the verb list

• Options are to re-word 
the attribute to use a 
different operative verb, 
or add the new verb to 
the list for the project
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Documentation Library

• Configure the list of 
recognized verbs

This statement won’t parse as 
intended as the operative verb (love) 

is not in the default verb list.

https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Attributes/Configure_list_of_recognized_verbs.htm
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Documentation Library

• Translate policy models 
into other languages

• Create a form in a 
different language

• Example project: 
Travel Compensation

Adding a Translation Layer

• Create one or more translation layers, e.g. policy model in 
English, interview in choice of English, Spanish or French

• Even a partial translation layer is sufficient to demo the 
concept. Google Translate can be used for basic demos. Use a 
(human) translation expert for real implementations

• Generated forms can also be created in different languages
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English
policy model

… with Spanish 
translation layer

… and Chinese 
translation layer

https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Other_language_support/Translate_policy_model_other_language.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Forms/Create_a_form_in_a_different_language.htm
https://opalive-opa.custhelp.com/opalive_opa/web-determinations/startsession/Travel+Compensation
http://translate.google.com/
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Writing Rules in Other Languages

• Many languages available out-of-the-box for rule authoring

– For additional languages, create a custom language parser

• Function Reference is available in out-of-the-box languages

• When creating a new project, select the desired Rule 
Language and Rule Region

• Rule Language:

– Language in which rule documents are written

• Rule Region:

– Affects currency, numeric and date formatting of data entered 
and displayed

– Affects parsing of currency and number constants in rule docs
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Documentation Library

• Write rules in other 
languages

• Change the user interface 
language for Policy 
Modeling

• Change the language of 
the Intelligent Advisor 
Hub

• Custom language support

• Function references in 
different languages

https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Other_language_support/Write_rules_in_other_languages.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Other_language_support/Change_UI_language_Policy_Modeling.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Other_language_support/Change_language_Policy_Automation_Hub.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Other_language_support/Custom_language_support.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Work_with_rules/Function_references/Function_references.htm
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Intermediate Attributes

• Intermediate attributes can be added to make the Explanation 
more meaningful

– These two examples have identical core logic, but Example 2 
has a more meaningful Explanation due to the inclusion of 
intermediate attributes
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Documentation Library

• Design an explanation

• Add more information 
to an explanation

• Add intermediate 
rules or text 
substitution

• Replace grouping 
operators with new 
attributes

* Explanations previously called Decision Reports

Example 1 Example 2

https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Explanations/Design_an_explanation.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Explanations/Add_more_information_to_an_explanation.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Explanations/Add_intermediate_rules_or_text_substitution.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Work_with_rules/Write_rules_in_Word/Replace_grouping_operators_with_new_attributes.htm
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Rule Tags

• Structural elements in legislation (e.g. section, paragraph, 
article) and policy (e.g. chapter, guideline) can be captured in 
rules and displayed in explanations in an interview
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Documentation Library

• Add reference tags to a 
Word rule

• Add reference tags to an 
Excel rule

• Show reference tags in 
an explanation

• Example project: 
Travel Compensation

* Rule Tags previously called Structural Elements. Explanations previously called Decision Reports.

Rule with rule tags

Rule tags in an explanation
in an interview

https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Work_with_rules/Write_rules_in_Word/Add_reference_tags_to_Word_rule.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Work_with_rules/Write_rules_in_Excel/Add_reference_tags_to_Excel_rule.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Explanations/Show_reference_tags_in_explanation.htm
https://opalive-opa.custhelp.com/opalive_opa/web-determinations/startsession/Travel+Compensation
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Trimming Explanations – Attributes

• Explanations automatically generated based on the logic, 
language and structure of the rules can be extremely verbose

• Can trim Explanations using Silent and Invisible settings on the 
attribute in the Data tab

– Silent: Hide all logic nested below a particular attribute

– Invisible: Hide the attribute only
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Documentation Library

• Hide information in an 
explanation

• Hide attributes in an 
explanation

* Explanations previously called Decision Reports

Options for Booleans Options for non-Booleans

https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Explanations/Hide_information_in_an_explanation.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Explanations/Hide_attributes_in_explanation.htm
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Documentation Library

• Hide information in an 
explanation

• Hide a relationship 
in the explanation

Trimming Explanations – Relationships

• Silent and Invisible can be applied to relationships

– See examples below with a containment relationship (the 
household members) and an inferred relationship (the children)
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* Explanations previously called Decision Reports

No trimming

Invisible on 
containment 
relationship

Silent and 
Invisible on 
inferred 
relationship

Invisible set on 
both relationships

Invisible on 
containment 
relationship

Silent on 
inferred 
relationship

Invisible set on 
the containment 
relationship

https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Explanations/Hide_information_in_an_explanation.htm
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Policy_Modeling_User_Guide/Explanations/Hide_relationship_in_explanation.htm
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Documentation and Further Information
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Further Information

Intelligent Advisor on the Oracle Technology Network

– Documentation Library

– Best Practice Documentation

– Tutorials, whitepapers, datasheets

Ask questions on the Intelligent Advisor Forum

Follow on Twitter or the Intelligent Advisor Blog
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https://www.oracle.com/applications/customer-experience/service/intelligent-advisor/policy-automation.html
https://documentation.custhelp.com/euf/assets/devdocs/unversioned/IntelligentAdvisor/en/Content/Guides/Default.htm
https://community.oracle.com/community/groundbreakers/oracle-applications/industries/oracle_policy_automation/oracle_policy_automation_-_general_discussion
http://twitter.com/OracleOPA
https://blogs.oracle.com/OPA/
https://twitter.com/OracleOPA
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